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General information 
IDEA applications are protected by several protection tools. A valid license is always required for 

these protections tools, in order to run the programs. The following installation types are available: 

• Standalone installation (Local key) 

• Network installation (Network key) 

Both Local and Network licenses are software licenses, bound to the computer hardware. The 

license must be deactivated (returned to the IDEA-RS server) before significant hardware changes 

(hard drive replacement, BIOS flash) and activated again after finishing the changes. 

All the licensing operations and management are performed through a separate application called 

License Manager, which is installed by default with IDEA Statica. If the IDEA Statica cannot find the 

proper license to run, a warning appears and a question to run the License manager is displayed.

  

License manager 

The License manager can be run: 

• Using Windows command Start > All Programs > IDEA StatiCa > License manager 

• Using command File > License manager in IDEA applications 

• Using command License in the main IDEA StatiCa application  

 

 



1. Trial license 
 

1.1 Activating a trial license on workstation 
 

To be able to manage the trial license on the workstation, the Local key tab must be 

available in the License manager dialog. The particular workstation must be 

connected to the Internet in the moment of activation.  

 

Step 1: Copy Activation key (which you received) into the Activation key edit box in 

Activation group.  

Step 2: Click Activate button beside the Activation key text box.  The program will 

connect to the IDEA-RS server and the workstation will be authorized.  

 

1.2 Transferring the trial license to another computer 
  

If it is required to use the program on another workstation or parts of the hardware will 

be changed, or you need to reinstall of operating system, etc., it is necessary to transfer 

the license back to the Activation server before any of the above are made. 

To transfer the license, follow these steps: 

Step 1: Copy the Activation key into the Activation key edit box in the Activation 

group.  

Step 2: Click Deactivate button beside the Activation key text box.  The program will 

connect to the internet and the license will be transferred back to the IDEA-RS server. 

After transferring the license back to the IDEA-RS server, it can be activated on another 

(or the same) workstation following the steps described at paragraph 1.1 



2. Activating a purchased license on workstation 
A purchased license can be one of the following license types: 

• Local key – this is the default licensing mode where license is stored on the current 

workstation or on the USB flash disc. If the USB flash disc with license is attached, the license 

is taken from the USB only, otherwise the license is taken from the workstation.  

• Network key – the licenses for workstations are provided from the Eleckey Network license 

server.  

• Network key HASP – the licenses for workstations are provided from network HASP 

hardware key.  

In order to activate a purchased license, you need 2 things: an activation key (a 20-digits string), 

and a license file that must be present on the workstation. 

 

2.1 Local key (standalone installation)  
 

To use Local key licensing mode, open License Manager and make sure that the option 

Local key in the group Select license type is selected, and the computer is connected 

to the Internet. 

 

Step 1: Copy the Activation key (which you have received from the local distributor) 

into the Activation key edit box in Activation group.  

Step 2: Click Activate button beside the Activation key text box.  The program will 

connect to the IDEA-RS server and the workstation will be authorized.  

Step 3: Click on the Load license file… button and find the location where you 

have stored the license file you have received by email. Select it and click Open. 



2.2 USB key (standalone installation) 
 

To be able to manage the license on the USB flash disc, make sure that before launching 

the License Manager, the USB key is attached to the USB port, and follow these steps: 

Step 1: Open License manager and make sure that the tab USB key is visible. 

Step 2: Enter Activation key into the Activation key edit box. 

Step 3: Click Activate button beside the Activation key text box.  

The program connects to the IDEA-RS server and the license on the USB flash disc is 

authorized. 

Step 4: Copy and paste the License file you have received from your local 

distributor in either one of these 2 locations:  

• C:\ProgramData\IDEARS\License (Note: this is hidden folder by default) 

• C:\Program Files\IDEAStatiCa\StatiCa8  

 

 

 
Note: The process of USB license upgrade (new modules, prolongation of time-limited 

version) is similar to the upgrade of the license on the workstation (see 1.3) 

 

 

 



2.3 Transferring Local key license to another computer 
 

If it is required to use the program on another workstation or parts of the hardware will 

be changed, or you need to reinstall of operating system, etc., it is necessary to transfer 

the license back to the Activation server before any of the above are made. To transfer 

the license, follow these steps: 

Step 1: Copy the Activation key into the Activation key edit box in the Activation 

group.  

Step 2: Click Deactivate button beside the Activation key text box.  The program will 

connect to the internet and the license will be transferred back to the IDEA-RS server. 

After transferring the license back to the IDEA-RS server, it can be activated on another 

(or the same) workstation following the steps described at paragraph 2.1. 

 

2.4 Upgrading license (re-activation) 
 

The process of license upgrade (new modules, prolongation of time-limited version) is 

similar to the initial activation. After receiving information from your reseller that re-

activation is enabled, start the License Manager. 

Enter Activation key into the Activation key edit box in the Activation group. Click 

Activate button beside the Activation key text box. Program connects to the IDEA-RS 

server and the existing license is updated (re-activated). 

 

2.5 Updating the content of HASP hardware USB key 
 

The key can be updated using V2C file. After receiving the update V2C file run the 

Sentinel Admin Control Centre on computer, into which the HASP USB key is plugged. 

Click menu command Options > Update/Attach. Click Select file and then click Apply 

file to update the content of USB hardware key. 

 



3 Network licensing (Eleckey) 
For Eleckey network licensing, a separate application called Network License Server (NLS) 

must be installed on one computer (usually this is the server of the office, but not necessarily, it 

can be any computer on the network), which will provide the individual licenses for the 

particular workstations. 

Of course, the on-line communication between the workstations and the Network License 

Server is mandatory when using the Eleckey network protection. It means, that there should be 

already configured a network between the different computers and the server, and the TCP-

port of the Network License Server has to be enabled on the server firewall (default port of 

Network License server is 1245). 

To configure a network installation of IDEA Statica, there are 3 steps involved: 

1. Installation of the Network License Server (NLS) on the chosen computer 

2. Activation of the license 

3. Installation of IDEA Statica on all workstations 

These steps are described below: 

 

 

3.1 Installation of the Network License Server (NLS)  
 

The NLS (and other necessary tools for the network installation) are packed in the 

archive-file NetKeyTools.zip that can be downloaded from our website by clicking this link  

After you download it, unzip the file in a folder. 

To install the NLS‚ run the NetKey License Server 4.0.exe or the MSI installation package‚ 

NetKey License Server 4.0 EK.msi. At the end of setup, the license server is started and 

offers the option to run NLS as a service or as a GUI-program under the current user 

account. We recommend to run it as a GUI-program. 

If the NLS runs as a service, administrator has to stop the service if he wants to run the 

NLS in GUI mode, otherwise a conflict message of the NLS TCP-ports appears. 

If the license server is running as service, the GUI version of license server (second 

instance of network license server) cannot be started (TCPIP port conflict appears). The 

service must be stopped before launching the GUI version.  

 

 

 

 

http://www.idea-rs.com/wp-content/uploads/licencetools/NetKeyTools.zip


3.2 Activation of the license  
  

The activation of the network license is done through the tool REGISTER.EXE that you will 

also find in the zip folder NetKeyTools.zip  

We recommend to run this tool from the same computer that the NLS has been installed, 

because it will make the procedure much easier. Of course this computer has to be 

connected to the Internet at the moment when activating the license. In case that is not 

possible, please see paragraph   

In order to activate the license, follow these steps: 

Step 1: Run the tool ‘Register.exe’ 

Step 2: Copy the Activation Key into the edit box Activation key. 

Step 3: Click on the Activate button. The tool connects with the Activation server and it 

activates the license on the NLS. 

 

 

 

 

 

 

 

 

 



3.2.1 Running REGISTER.EXE from another PC 

  
If you need to run tool REGISTER.EXE from another computer, (other than the 

computer where the NLS has been installed), it is necessary to adapt the settings in 

the configuration file ‘NETKEY.INI’ (which you can find in the network tools you have 

downloaded), to set the address/name of the computer, where the NLS has been 

installed. In this case the computer, which runs REGISTER.EXE establishes a 

connection to the server with the NLS and a second connection to the Activation 

server (over Internet). 

The default setting is Host=localhost – it assumes that tool REGISTER.EXE is run on 

the computer, which runs the NLS. 

These are the contents of the file NETKEY.INI: 

[Network] 

ServerAddress= 

ServerPort=1245 

Host=  

The address of the Network License Server must be specified as an IP-address in 

the line ServerAddress=  or as a computer name in the line Host=  

The IP address must be resolvable from the specified computer name using DNS.  

It is necessary to set the current port number in the line ServerPort= in cases that 

the Network License Server does not run on the default port (1245).  

  



3.3 Installation of IDEA Statica on all workstations 

 
The IDEA StatiCa application must be installed on all required workstations. After the 

setup has finished, open License Manager. The licensing mode Network key must be 

set on each workstation in the License manager.  

 

  
The following properties of the connection to the Eleckey network server can be set on 

the Network key tab: 

• License server host name – the DNS name of computer, where the Eleckey Network 

License server is running. 

• License server address – the IP address of computer, where the Eleckey Network 

License server (NLS) is running. 

• Port – the number of port, on which the Eleckey Network License server service is 

available. The default port number is 1245. 

 

Note: Normally, you only have to define correctly the License server address, which is enough 

to establish the connection between the workstation and the license server. If both License 

server address and License server hostname are specified, the IP address resolved using DNS 

from the host name must match the specified License server address.  

Finally, you have to install the License file you have received from your local 

distributor in all local workstations: Click on the Load license file… button and find 

the location where you have stored the license file you have received by email. 

Select it and click Open. 

 

 



3.4 Other network operations 

 

3.4.1 Upgrading the license 
 

To update the license (upgrade to new version, new modules purchased) you must 

follow similar steps as the ones for the initial activation. After receiving information 

from your reseller that the license can be re-activated, run REGISTER.EXE utility, copy 

your Activation Key to the Activation key edit box and click Activate to reactivate the 

license.  

 

3.4.2 Transfer of a network license to another computer 

 
When the administrator needs to move the network license to another computer (or 

change of hardware, reinstallation of the operating system,  etc.), then a transfer 

procedure has to be followed.  

The transfer moves the license back to the IDEA-RS server, and then it is possible to re-

activate license on the other computer. In order to transfer the license, follow these 

steps: 

Step 1: Run the tool TRANSFER.EXE. 

Step 2: Copy the Activation key into the edit box Activation key.  

Step 3: Click on the button Deactivate. 

The tool removes the license from the NLS, connects to the IDEA-RS server and returns 

the license. If TRANSFER.EXE communicates with NLS where no license is installed, the 

Deactivate button is not available. There is a button Activate available instead and it 

has the same functionality as button Activate in REGISTER.EXE tool. 

After transferring the license back to the IDEA-RS server, the administrator can re-

activate it on another computer following the steps described above.  

 

 

 

 

 

 



3.4.3 Using a HASP network license  

 
Instead of hardware-dependant protection, a HASP network protection can be used. In 

that case the licenses are stored in hardware USB key. The key is plugged in to the 

computer in the network that acts as a license server. 

The on-line communication between the workstations and the license server is 

mandatory when using the HASP network protection. It means, that appropriate ports 

must be open on the computer, where the HASP key is plugged in. The default ports are 

TCP/UDP 1947. 

Installation on local workstations 

It is not required to install any drivers on local workstations when working in local 

network. The IDEA StatiCa must be installed on required workstations. The licensing 

mode HASP network key must be set on each workstation in the License manager.  

 

If option Show this dialog during application start-up, the License manager is 

launched before launching IDEAStatiCa.exe to be able to modify the list of required 

licensed modules. 

 

 

 



Selection of required modules 

Group of modules or individual modules, for which the licenses should be checked out 

from the license server, can be selected/unselected in the group Modules on the tab 

Net key HASP. 

If option Commercial modules is selected, the sets of licensed modules, which 

corresponds to business model of IDEA StatiCa applications, can be selected. The 

selected commercial module is transferred to the set of checked out technical modules. 

The union of required technical modules is created when more of commercial modules 

are selected. 

If option Technical modules is selected, single modules to check out the license, are 

selected. 

Communication between workstation and license server 

The HASP USB key is searched in network using broadcast query by default. 

To get the list of available HASP USB keys of IDEA company and the content of the keys 

(list of modules and number of available licenses per module) click Find key above the 

list Found keys. 

IP address – enter IP address of server, where the HASP USB key is plugged in. The 

address must be entered, if the workstation is in another network than the license 

server or the server cannot be found using the broadcast query. If the IP address is 

specified, the file 

HASP_108213.INI is created in the directory %USERPROFILE%\APPDATA\LOCAL\SAFENET 

SENTINEL\SENTINEL LDK  

The file contains only one item: SERVERADDR = defined address 

Remark: the application must be re-launched after the change IP address to apply the 

new content of INI file. The INI file can be created also manually, without setting the IP 

address in License manager – than the content of INI file may not correspond with the 

real INI file content. 

 

 

 

 

 

 

 

 

 



4 Troubleshooting 
 

4.1 Eleckey Network license troubleshooting 
 

4.1.1 Activation troubleshooting  

 
Activation utility REGISTER.EXE /TRANSFER.EXE displays message “Cannot connect 

to NetKey License server”. Possible reasons: 

• Service, which provides licenses to the network, does not run on the server – NetKey 

License server (neither as application, nor as service) 

• The address/name of computer, which runs Netkey license server, is not specified 

correctly in NETKEY.INI file (in directory, where utilities REGISTER.EXE /TRANSFER.EXE 

are stored) 

• Communication between utilities REGISTER.EXE /TRANSFER.EXE and license server is 

blocked – the required TCP port is blocked on firewall 

 

Activation utility REGISTER.EXE /TRANSFER.EXE) displays message “Cannot connect 

to Activation server. Please check your internet connection and try again”. 

If this message appears during activation and the internet connection works properly on 

computer, where REGISTER.EXE/TRANSFER.EXE are run (ping to ‘www3.idea-rs.com’ gets 

replies), try to run utility REGISTER.EXE (TRANSFER.EXE) on another workstation in the 

network.  

File NETKEY.INI has to be adapted in such case (in directory, where utilities REGISTER.EXE 

/TRANSFER.EXE are stored). Set IP address of computer, which runs NetKey License 

server, into the row ServerAddress=  and adapt row Host= accordingly. The file looks like 

following: 

  

[Network] 

ServerAddress=192.168.1.2 

ServerPort=1245 

Host= 

 

where 192.168.1.2 is IP of server running NetKey License server.  

After launching REGISTER.EXE /TRANSFER.EXE the utility runs on workstation and 

communicates with the Netkey License server on the one side over the local network and 

with the IDEA Activation server on the second side over the internet.  

This procedure can be used for remote management of licenses over internet (requires to 

have the port of Netkey License server to be available from the internet on firewall). 



4.1.2 Application on workstations troubleshooting 
 

Application displays message “Cannot connect to NetKey License server”. 

Possible reasons: 

• Service, which provides licenses to the network, does not run on the server – 

NetKey License server (neither as application, nor as service) 

• The address/name of computer, which runs Netkey license server, is not 

specified correctly in NETKEY.INI file (in application directory) 

• Communication between application and the license server is blocked – the 

required TCP port is blocked on firewall 

 

Application displays message “NetKey: License is required”.  

Possible reasons: 

o No licenses were activated on License server. 

 

Application displays message “Netkey: Number of users reached the limit”: 

The maximal number of concurrent users connected to the License server has 

been reached 

 

Application displays message: “NetKey: Invalid key device”. Possible reasons: 

The license got corrupt on the Network license server (hardware changed, virtual 

machine moved to another host). The license must be re-activated. 

 

 

 

 

 

 

 

 

 

 

 



4.2 HASP troubleshooting 

4.2.1 Missing drivers 
 

If drivers for HASP hardware key are not installed on the computer, where the HASP USB 

hardware key is plugged in, the drivers must be installed. Either the GUI installation 

package Sentinel HASP/LDK - Windows GUI Run-time Installer or command line 

installation package Sentinel HASP/LDK - Command Line Run-time Installer can be 

downloaded from the manufacturer web site:  

http://sentinelcustomer.safenet-inc.com/sentineldownloads/ 

 

Sentinel Admin control centre 

The administration interface of the licencing service is available on the computer after 

installing Sentinel HASP/LDK. 

To open the web administration interface Sentinel Admin Control Centre, open the URL 

http://localhost:1947/ in your browser. The vendor ID of IDEA company hardware keys is 

180 213. 

To display key details (list of modules, connected users etc.) click menu command 

Options > Features. 

 

 

4.2.2 Workstation cannot detect network key 
 

By default, a broadcast query is used by default to find the server with attached HASP 

hardware key or INI file created according to specified IP address of license server is used 

to locate the license server – see 5.1.2 Communication between workstation and 

license server, thus it is not necessary to install any drives on individual workstations.  

However, if the broadcast query and the search according to INI file may fail to detect the 

key (network restrictions, workstation behind the firewall etc.). Then the same hardware 

key driver package as for server must be installed on the workstation (see 5.2.1 Hardware 

key drivers).  

Launch Sentinel Admin Control Center on workstation (use browser URL 

http://localhost:1947/). Click Configuration in left side menu. On tab Access to remote 

license managers select option Aggressive search for Remote Licenses and enter the IP 

address of the server with attached HASP hardware key into the field Specify Search 

Parameters. 

After the changes are stored and application is restarted, the key is searched using direct 

query to specified IP address. 

http://sentinelcustomer.safenet-inc.com/sentineldownloads/
http://localhost:1947/
http://localhost:1947/


 

 

 

 

 

 

 

 

 

For any questions regarding the installation, or the features of IDEA Statica, please contact us at 

support@techscience.co.uk 

 

 

21 Horizon house 

Juniper drive, Battersea 

London, SW18 1GH 

United Kingdom 

 

Phone: +44(0)20 3579 9397 

www.techscience.co.uk 

 

mailto:support@techscience.co.uk
http://www.techscience.co.uk/

	General information
	1. Trial license
	1.1 Activating a trial license on workstation
	1.2 Transferring the trial license to another computer

	2. Activating a purchased license on workstation
	2.1 Local key (standalone installation)
	2.2 USB key (standalone installation)
	2.3 Transferring Local key license to another computer
	2.4 Upgrading license (re-activation)
	2.5 Updating the content of HASP hardware USB key

	3 Network licensing (Eleckey)
	3.1 Installation of the Network License Server (NLS)
	3.2 Activation of the license
	3.2.1 Running REGISTER.EXE from another PC

	3.3 Installation of IDEA Statica on all workstations
	3.4 Other network operations
	3.4.1 Upgrading the license
	3.4.2 Transfer of a network license to another computer
	3.4.3 Using a HASP network license


	4 Troubleshooting
	4.1 Eleckey Network license troubleshooting
	4.1.1 Activation troubleshooting

	4.2 HASP troubleshooting
	4.2.1 Missing drivers
	4.2.2 Workstation cannot detect network key



